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Section 1 Trimble Business Center 5.0 
Note:  This section is for primarily administrators, it is provided to inspectors as background information. 

 

1.1 Introduction 
Trimble Business Center 5.0 is office software that utilizes both electronic engineering data and field data 

collected with SCS900 Tablet Edition site controller software (SCS) and Site Works. TBC 5.0 is used to 

prepare the project data for use in SCS900 & Site Works field software, manage field collected data and 

generate reports. Today we will be using TBC 5.0, Trimble SCS900 and Site Works Emulator and the 

data set for this training is located on your desktop in a folder called:  Training data set 2020. 

 

1.2 Creating Trimble Business Center Project 

 
1. Start by Opening Trimble Business Center by clicking the icon on your desk top  
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Figure 1 Trimble Business Center 

2. Next Click File > New Project in the upper left of the screen shown above 

 

  
 

1.3 Units 

 
3. Select the 2020 CTDOT Standard Template with the proper units of your project data. (Select 

US Survey Foot for this training) 
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4. Click OK 

 

1.4 Naming project 
1. Click File>Save Project As this will create a folder within your documents folder 

2. Name the Project File Training 2020 

 

 

1.5 Displaying the Electronic Engineering Data 
 

As explained above, EED is the data produced during the design phase. The MicroStation CAD files, 

InRoads or Open Roads coordinate geometry alignment files, and InRoads orOpen Roads surface files. 

These can be leveraged during construction for verification purposes. 

 

1. Locate the Training 2020 folder on your desk top 

 

2. Import the project data by dragging and dropping all ? files into Business Center one at a time, 

Listed below is the EED for this project.  

The dxf format is the converted MicroStation CAD files. The XML format is the converted InRoads 

files, which the alignment files having ALG in the name and surface files having surface in the 

name. 

 

   

Change pic when other data is brought in. 

3. When bringing surface xml files (DTM) into TBC the software will prompt you to select a 

definition shown in the box below 

4. Choose the first option>Point/Breakline-based definition 
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5. Click Import and you will see the file displayed on your screen 

 

6. Next drag and drop (EED_0134-0147_HW) 
 

 

 
 

 

 

 

 

 

7. Continue dragging and dropping the project EED into Business Center and click no to any 

errors or warnings 
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8. Next go to the View pull down from the top of the screen and make sure the View Filter 

Manager is displayed 

 
 

9. Next review the Layers and Surfaces within the View Filter manager 

a. Take time turning layers on and off 

b. Turn surfaces off and on 

 
10. Open the Project Explorer by clicking view and then Project Explorer option 

 

 

11. The Project Explorer will show you the EED that is in Business Center 
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Section 2 Job Site Manager 

2.1 Creating Job site 
 The Job site contains specific site project data that gets created in your project. The Job site gets 

assigned to the controller which assists in data transfer to the PC. Each project contains one job site but 

for multi-year projects the job site can become an external site in a new project bringing forward 

everything except the work orders.   

 Note: For this training proceed to step 4 

1. Start by Opening Trimble Business Center by clicking the icon on your desktop   

2. Select File>Open and browse to the location of the Business Center project 

 
D:\Users\username\Documents\Business Center >Training2020.vce 

 

3. Go to the Construction Data tab on the top of the interface window: 
 

 
 

4. Select Job Sites: 
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5. Click on Create new site 

6. Name the Job Site Training2020 

7. Click on the PC  to assign a controller to the job 

8. Click OK 
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2.2 Site Map 
 The site map is a 2D background map that can be toggled on and off from within the map options 

in SCS900. This map is primarily used for existing topo or survey ground file type maps. The 

limitation to this map is none of the layers can be turned on or off and none of the line work can be 

staked within the stakeout capability of SCS900.                                        

1. Next the Job Site manager will appear on your screen 

2. Scroll down to the Site map 
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3. Click the +/- button 
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4. Within your selection set check the existing survey file so that is the only graphics shown 

5. Turn off any layers you do not want to be shown in your site map 

6. Drag a window and select the existing ground file 

7. Click the Edit tab at the top of your TBCHCE  interface window 

8. Click Invert and see the number at the bottom of the screen, these ghost elements that cannot 

be seen in TBCHCE but need to be deleted so they do not show up in SCS900 in the field 

9. Next click Invert again and see the original selection light up as being selected 

                    

10. Click the Add button. This will let you select graphics from the site map to be displayed on the 

tablet in the field. 

11. Scroll down to verify the controller is listed in the box PC 1.1 in this case 
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12. Click the SCS Data Icon at the top of the screen. This is a standalone application that allows you to 

added survey control data and project calibration files to your project quickly and easily.  

     

 

 
 

 

13. Click the Add File to the far right of the screen and browse to the Training data 2018 folder on 

your desk top to access the .csv survey control file  

14. Repeat these steps and select the .dc calibration file 

15. Then click the red box at the top right of the screen to close the application 

16. Going back to the Job Site Manager notice the Site Calibration and Site Map are populated with 

data 
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17. The user has the ability to Reassign controllers if needed by clicking the Reassign button and select 

a new controller 

18. Close the Job Site Manager 
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2.3 Design Map 
 The Design map is usually the 2D proposed corridor model of the project. This map is located in 

the Design Manager. Layers can be turned on and off in SCS900 which cannot be done in the site 

map. Also the graphical line work can be used in the staking capability of the SCS900 software.  

  

1. Next go to the View Filter manager and turn on only your proposed design work. Also turn off any 

layers you don’t want shown in your design map. 
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2.3.1 Design model 
1. Go back to the Construction Data pull down and select Create Design: 

 

    
 

    

2. Name the Design: Design All Alignments 

 

 
 

 
 

3. Click the PC controller and then click OK 

4. Click Edit within the Model box shown 

 

 

 



Connecticut Department of Transportation GPS Construction Inspection 
 

Page | 18   

 

 
 

 

 
 

2.3.2 Alignments 
5. Next click the Alignment button and check all the alignments, then click OK. 
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6. Next go back to the Construction data pull down and  click Create Design 
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2.3.3 Surfaces 
7. Name the second design Existing Surface 

8. Click OK 

9. Click edit in the model section 

10. Next select the Surface button, next you will see the available surfaces to add to your design, for 

this training select Existing Surface 

 

11. Click OK  

12. Next click the Edit 
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13. Next select surface and also select existing under the surface tab and click ok 
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14. Turn off any layers you do not want shown in your design map, such as the design contours 

15. Drag a box to high light the Design map content and click add, you will see the number of 

object shown in the box. 

16. Click OK and you will see the number of objects within the Design map section 

17. Also make sure your design is assigned to a controller at the bottom of the Design manager 
 

2.4 Work Orders 

2.4.1 Creating Work Orders 
1. Go to the Construction Data pull down and select the Controller Manager: 

 

 
 

 

2. If there is nothing populated in the box you must refer to Section 2.51 Syncing thumb drive to PC 

 

 
 

3. If you see the PC  listed then you can proceed with the training 
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4. Close the Controller Manager box 

5. Go to the Construction data pull down and select Create in the Work Order section 

 

 
 

 
6. Name the Work Order 20200226seed and click OK 
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7. The Work Order box will appear as shown below 

 

 
 

 

 

 

 

8. Review the information in the Work Order section 

9. Pick Design: from the pull down to assign to the work order 

10. For this work order we will assign the PRO which is the base line geometry 

11. This will display the station and offset dynamically on the tablet 

12. Change the work order status accordingly 
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13. Click View to review the work order graphics then clicking OK. 

 

 
14. Repeat and create a new Work order called 20200226seed assigning the Design all 

alignments to the work order 

15. Click OK 
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2.5 Data Transfer 

2.5.1 Transferring data from PC to Tablet or controller 
Once the work order is complete on the PC the work order file gets transferred from the Trimble 

Synchronizer data folder located in the C: drive on your PC. The work order file gets copied to the 

synchronizer data folder on the tablet or data collector. 

This can be done with a USB flash drive. Next section we will review the process to sync the flash drive 

to your Business Center project on the PC and your scs900 project on the tablet or data collector.  
 

1. Open the explorer window and navigate to the C: >Trimble Synchronizer Data on the PC 
 

 
 

2. Open the Synchronizer data folder 

3. Next click on the PC folder 

4. Next click the Trimble SCS900 Data folder 

5. Review your project files 

6. Place the flash drive provided into the tablet or data collector and copy the work order file to the 

same location onto the tablet or data collector 
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Section 3 SCS900 Site Controller Software 

3.1 Introduction 
The SCS900 software is a site measurement tool that streamlines earthworks and surface finishing 

operations. It enables construction inspectors to measure material volumes, monitor grades and laid 

material thicknesses, and to perform site measurement tasks such as point, line, and surface 

stakeout. The next generation of SCS900 called Siteworks, and is introduced in Section 9. 
 

1. Open Trimble SCS900 Emulator by clicking on the emulator icon on your desk top 

 

 

 
 

 

General Note:  

The Site: Work Order: and Design: names will vary depending on what you named them previously in TBCHCE
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2. Mode will be set to Rover 

3. Connection Type will be set to Emulator 

4. Correction method will be set to radio inside the receiver 

5. Network ID will be set 1. 

6. Connected to Base will be Emulator/Zephyr 

7. Antenna height will be 6.562usft 
 

 

 

 

 
8. Click Accept 

9. The software will prompt you to calibrate,  click NO because the emulator has false coordinates 

streaming and the software will not be able to make sense of the coordinate geometry 

10. Select Road Job by clicking the alignment on the screen or select the box in the upper right corner 

of the screen and choose the base line you wish to use. 
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11. Click: Accept 
 

3.2 Taking Field Measurements 

3.2.1 Measuring a surface area 
1. Click the icon circled in Red below: 

 

 

 
2. Next click on the New Line Tab and type in seed 

3. Set Line type to volume boundary 
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4. Next click the Zoom icon shown highlighted in yellow 
 

 
 

 
 

5. Drag a window to zoom in on the active alignment shown with the directional arrows 

6. Make sure you click the zoom icon again to release the command 

7. Next click measure and take a measurement along the seeded area using a volume boundary
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8. Next click the measure icon and take shots around your seeded area using a volume boundary 
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9. Upon your last shot click the icon circled in red to close the shape 
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10. Click and hold on the shape until it gives you the line information 

 

 

 
 

11. Click line information and review data 

 

 

12. Click Close 
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13. Select any point and choose the point information and scroll down to the station and 

offset to the base line  
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3.2.2 Measuring a Feature 
 

In SCS900 features are contract items measured in a linear type series of shots. For example, line 

stripping, MBR, and drainage pipes. The exercise below shows the measurement of a drainage pipe 

from catch basin to catch basin 

1. Locate the drainage pipe at station 51+20 if the reference line is not selected go to the Trimble icon 

 
2. Next select reference line  
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3. Next click the baseline on the screen and click OK 

 

 

 
 

 
 

4. Click the measure type icon 

 

 
 

5. Navigate to the New Line tab 
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6. Line Name: pipe 

7. Change the Line type:  Line 

8. Click Accept 

9. Next line up the target with the start of the pipe and click the Measure icon 

 

 
 

10. Next navigate to the end of the pipe and click measure 
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11. To end the measurement click the measurement type icon 
 
 

 
 

12. Next click Accept to finalize the measurement 

 

 
 

 

 

*Note: The only way to end a measured feature is to start a new line 
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13. Next long click on the measured line (pipe) and click on the Line Information 
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14. Review line information and notice your length for measurement/payment 
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3.3 Volume Methods 

 
This exercise shows how to take work order data and create a design surface used for volumetric 

calculation real time in the field 

3.3.1 Saving a Work Order as a Design Surface 
1. Click the Home icon 

 

 
 

2. Next click the Import/Export icon 

 

 
 

3. Next click Surface as Design 

 

 
 

4. Name the surface seed1 and Include Measured Line work 
 

 
 

5. Click Accept 

 



Connecticut Department of Transportation GPS Construction Inspection 
 

Page | 42   

 

6. Select Use volume boundary or closed break line 

 

 
 
7. Click Accept and now the work order is available as a design for future volume computations 

 
 

 

3.3.2 Measuring a stock pile for volume quantities 
 

 

1. Next go to the Home icon and then click Site 
 

     

 

 
 

2. Click the Open Site icon 
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3. Click New Work Order and name it 20200226wsa and click Finish 
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4. In the Open Site box in the design area select (No Design Needed) and Accept 
 

 

 
 

 

5. Next click measure type         navigate to new line tab and mane your volume boundary 

WSA 

 

6. Click Line Type drop down and select volume boundary click Accept 
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7. Next take shots around the base of the stock pile 

 

 
 

8. Close the volume boundary by clicking the icon shown     
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9. Select Measure Type and select the Point tab and name your points wsa and click accept when finished 

 

 
 

 

10. Take shots over the pile within the volume boundary  
 

 

 
 

11. Next go to the Home icon and click COGO         

 

12. Click Review and edit data 
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13. Select the volume boundary created above click Accept 

 

 
 

14. Review your calculation  

 

Note: The emulator may not show an answer due to fake coordinates and elevations but in the field, it works great! If 

there are WSA BINS, shoot a volume boundary around the inside of the bin if there is dirt already in the bin change the 

rod height to 12.562 to locate the bottom of the bin. Next change the shot type to Point and take several shots all over 

the pile of dirt. Please ask question during class or call me for support.
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Section 4 Creating new Layers and Filters to 
manage field collected work order data 

 

4.1 New Layers 
 This section will help understand Layers, which are unique characteristics of CAD or field data 

displayed in the TBC project. In this section, you will see the importance to put each Work order on 

its own Layer. We will also use Filters, which are Layer driven to allow us to Dimension our field 

data and or put Text into the CAD project. All these capabilities improve our Reporting capability. 

  

1. Open project 

2. Imported Work Order: Display any line work within a work order into the TBCHCE project by 

clicking the Import Results icon 

 

 
 

 

 

3. The work order data is then selected in the selection set so only the work order is shown on the screen 

(disregard the name of the example and choose the work order you work on earlier) 
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4. Drag a window and select the field data 

 
 

 

5. Right click and select properties 
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6. Click in the layer section  

 

 

 

7. Scroll down to the New Layer  
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8. Select New Layer 

9. Name it the same as the work order (20200227mbr) 

10. Give it a color and thickness of your liking 

        
11. Click OK 

4.2 New Filters 
 

12. Next go to the filter and change it to All 

              
 

 

13. Copy the filter and name it the same as the work order 

            

14. The filters are layer driven turn on and off as necessary. 

15. This will allow you to dimension and put text into your filter for reporting purposes 

16. When you are happy with your filter, lock it!  

 

            

             

17. Next, open the report utility, and import the record and follow the next section of this document. 
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Section 5 Create Record .txt file for reporting 

using SCS report utility-64 

5.1 SCS Report Utility 
 The SCS Report Utility is an Excel file specifically designed to populate field-collected data from 

SCS900 field software.  We have standardized on the custom report capabilities shown below but this 

does not limit the use of other TBCHCE reports that maybe needed. This file can be, opened 

separately as well as within TBCHCE under the Reporting tab. Due to our state computer restrictions 

the computer engineering support person will need to access your PC remotely and put the report 

utility where it belongs. This lab show the manual process but we will also have the file where is 

belongs on the training PC so you will see both methods. 

 
1. With the TBC project open, navigate to the Construction Data and click Report within the work 

order ribbon 

 

 

 
 

 

2. Select the work order you want to report 
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3. The Report Utility will open showing all of the field collected data  

 
 

4. Next click No.2 Reports 
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5.2 Custom Reporting 
5. Go to Custom Reports and select what you want to display 
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6. Click OK 

 

 
 

7. Next go to the Report Tab at the bottom of the report utility 
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8. Copy and paste the computed value generated from the COGO section of SCS900 
 

 
 

9. If Business Center is open the project area use the snipping tool to take a graphical snap shot of 

the CAD graphics and copy/paste into the report utility 

 

 

 

 

 
10. Save as Adobe PDF and attach into your DWR in Site Manager 
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Section 6 SCS900 Training exercise: Layers, 
Filters, Dimensions, Text and Reports 

 
This exercise will help understand Layers, which are unique characteristics of CAD or field data 

displayed in the TBCHCE project. In this exercise, we ask you to put each Work order on its own 

Layer. We will also use Filters, which are Layer driven to allow us to Dimension our field data 

and or put Text into the CAD project. All these capabilities improve our Reporting capability.  

 

 6.1 Training Exercise 
  

1. Collect field data using SCS900 Emulator (preferably a surface or area) 

2. Open TBCHCE and import the work order 

3. Select the “work order” from within the “selection set” so the work order 

information is the only data shown on the screen 

4. Drag a window and select the field data shown on the screen 

5. Right click and select properties 

6. In the Layer area select the down arrow to the right and scroll down to Layer 

Manager 

7. Select new layer  

8. Name the layer the same name as the work order, doing this will allow you to put 

the work order in a filter 

9. Next Create new Filter and name it the same as the Work order and the Layer 

10. This filter can be, locked to prevent changing what is, displayed in the filter, thus 

keeping the source information secure. 

11. At the top left of your TBCHCE project screen, set your selection set to 

“Everything”  

12. Within TBCHCE go to the project explorer, and open the imported data leaf 

13. Choose a design or field data by clicking it in the file explorer and then right 

clicking and click “Select Members” this will high light the file’s data  

14. Go back to the view filter manager and click the “Hide layers of selected objects”, 

this will turn off bulk layers as you begin to create your filter 

15. When you have, the necessary layers off within your filter go to the TEXT icon at 

the top of the CAD tab and make sure the layer is set to the new layer matching 

the work order.  

16. Dimension or input text as you desire 
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Section 7 Trimble Siteworks  

3.3 Introduction 
The Siteworks software is a site measurement tool that streamlines earthworks and surface finishing 

operations. It enables construction inspectors to measure material volumes, monitor grades and laid 

material thicknesses, and to perform site measurement tasks such as point, line, and surface 

stakeout. 

 

 

 

1. Click on the Siteworks Icon    

 

 

2. Click ok through the Info box explaining the software running in training is only an emulator 

3. Next select the same Open Project info as shown in clip below 

 

 

 
 

 

4. When the project open click no to the calibration message as we are using an emulator for this 

training. 
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5. Next click the       and select the alignment you wish to reference your field shots. 

 

 

 

 

 
 

6. Click Accept 
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7. Click Accept again after you are sure you picked the correct alignment 

 

 

 

 
 

 

 

8. Review the new Siteworks interface, 3 separate screens 
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9. Click the measurement type icon      

 

 

 

10. In the Measure type box make the Line name mbr and the Line Type to Line and click Accept 
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11. Click the  starting at the beginning of the MBR and continue to take shots along the MBR 

 

 
 

12. Once you have completed your shots click the Measurement Type button and select new line to 

release old line 
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13. The orange line will turn to a thin black line after you select new line 

 

 
14. Next hold down on the line with the target until the Select option appears select the mbr1 
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15. Next select Line Information 

 

 

 

 

16. Review the MBR line information 

 

 
 

17. Many options in Siteworks are the same as SCS900 just in a different interface Please take time to 

navigate around the software. 
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Section 8 Trouble shooting TBCHCE & SCS900 

for GPS/RTS technology 
Specific Issues 

SCS 900 Corrupt calibration file        
Bad or negative vertical GPS elevations due to corrupt calibration file spread to project data collectors or 
tablets via the office synchronizer. This could be discovered by doing a system check within the GPS 
software or by seeing negative elevations. 

Solution 
Locate and delete corrupt calibration file from both PC and field device. Get back up from Project Wise or 
DVD and replace corrupt file .CAL file with good file. Do a system check in the field to a known point to 
verify the problem has been resolved. 
 

SCS 900 Unwanted Surface Triangles 
Mistakenly choosing surface and break line to measure a linear construction item such as curbing, which 
will create a spider web of triangles between each point as well as an additional surface to manage in your 
TBCHCE project. 

Solution 
Choose Feature and Line to measure linear features or in the COGO section of scs900 delete the break line 
and redraw as a line feature 
 

SCS 900 No station and offset data displayed in custom report 
Not getting station and offset for field measurements taken in scs900 

Solution 
Choose a roadway when opening SCS900 project or choose a reference line and assign it a starting station 
or choose an alignment within the reference line tab  
If you have already taken your shots but did none of the above, go to TBCHCE, open project, click project 
tab, click, Reports, select Station and Offset and Elevation report. Next delete geometry point data which is 
also included in this report. The surface tool, advanced drafting and data prep module will allow you to use 
this report capability. 
            

SCS 900 Receiver not seeing handheld 
During the receiver setup the hand held device does not recognize the receiver 

Solution 
Within the receiver setup, scan for device and select the serial number provided which will match the 
serial number under the GPS receiver. Also make sure the blue tooth is on within the wireless manager 
  

SCS 900 Empty Record file 
When creating a report using the SCS report utility the record is empty. This is because the user did not 
create a record .txt file  

Solution 
Go back to SCS900 on the tablet, open work order and select the Home key at the bottom left of the 
screen, click the Import/Export tab, click the measured data tab, select record.txt from the list of options 
and click Accept and transfer the work order back to the PC you are using TBCHCE and repeat the report 
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SCS 900 Volume boundary error 
When shooting a volume boundary in the field and you accidently take a bad shot and have to delete it 

Solution 
Go to the line type icon and select a new line, this will release you from the volume boundary, delete the 
bad shot, next to back to line type tab and select existing line and the volume boundary will continue 
where it was left off minus the deleted shot 
 

TBCHCE This layer is not visible in any graphic view 
Trying to put text or dimensions in your TBCHCE project but get the yellow dot of doom that says this layer 
is not visible in any graphic view   

Solution 
First put the work order data on its own layer, next create a new view filter and select which layers would 
be displayed or turned off, your work order layer would be on and when trying to do text select that new 
layer, if the yellow dot is still there this means you have a file selected in your selection set, this all need to 
be off and the layers managed through the filter, refer to work flow for more information 
 

Tablet Issue Internet not working on hand held device 
If you are not getting the internet on your hand held device when using a cell sim card for the first time 

Solution 
You need to run the cell start program located on the handheld this will activate the sim card, rarely do 
you have to do this twice  
 
 

Mifi Issue Mifi Available but not connected 
When trying to connect a data collector to a mifi device and the hand held keeps say “available” instead of 
“connected”  
Solution 
First make sure the mifi device has not been changed, if it has go to setting and do a factory reset, if it still 
does not recognize the hand held wireless manager and create a new wifi connection name it the same as 
the mifi, then try to connect again. 
 

TBCHCE Importing results but not seeing field data 
When transferring data from SCS900 to TBCHCE and it does not show up in the TBCHCE project 

Solution 
Within the TBCHCE project, “Import Results” under the Field data tab in the “work order” section, next 
turn it on in the “selection set” to view it until you put the data on its own “Layer” and put into its own 
“View filter” 
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